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How to Compare Two Proportions Using a Z-Test in SPSS

A two proportion Z-test in SPSS is a fundamental statistical analysis tool used when researchers

need to assess whether a meaningful difference exists between two independent population
proportions or percentages. This powerful parametric test allows us to draw conclusions about the
underlying populations based on sample data. The process involves meticulous data entry, case
weighting within the SPSS environment, and careful selection of the appropriate analysis
procedure, typically conducted through the Crosstabs functionality rather than a dedicated two-
sample proportions module often found in other statistical software.

Executing the test correctly requires selecting the "Two Independent Samples" approach, although
in SPSS, we primarily leverage the Chi-square test within the Crosstabs dialogue, which yields the
Z-test statistic and associated p-value for large samples. After running the analysis, the resulting p-
value serves as the crucial metric. This value quantifies the probability of obtaining the observed
difference in proportions if, in reality, no difference existed between the populations (i.e., if the null

hypothesis were true).

Interpreting the final output involves comparing the generated p-value against a predetermined
significance level, often set at 0.05. If the calculated p-value falls below this threshold, we conclude
that the observed difference is sufficiently rare to reject the assumption of equality, indicating that
the difference in proportions possesses statistical significance. This technique is invaluable across

disciplines, from determining if two medical treatments have differing success rates to comparing
consumer preference for two product versions across demographic groups.

A two proportion z-test is specifically utilized to determine if there is a statistically significant
disparity between two independent population proportions (pl and p2). Although SPSS does not
offer a distinct module explicitly labeled "Two Proportion Z-Test," the most accessible and reliable
method for generating the necessary output involves the utilization of the Analyze > Descriptive
Statistics > Crosstabs function. This method relies on the mathematical equivalence between the
squared Z-statistic and the Chi-square statistic with one degree of freedom, particularly effective
when dealing with large sample sizes typically encountered in proportion testing.

Understanding the Two Proportion Z-Test

The core objective of the two proportion Z-test is to evaluate the relationship between two
categorical variables, where one variable defines the two independent groups being compared
(e.g., Class A vs. Class B), and the second variable represents the binary outcome of interest (e.qg.,
Success vs. Failure, or Prefer vs. Do Not Prefer). This test is predicated on certain critical
assumptions, primarily that the samples are independent, the data is derived from a binomial
distribution, and that the sample sizes are large enough to ensure that the sampling distribution of
the difference in proportions approximates a normal distribution.

Statistically, the test works by calculating a pooled estimate of the overall success rate across both
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samples and then using this estimate to compute the Z-statistic. This calculated Z-statistic
measures how many standard errors the observed difference in sample proportions is away from
zero (the hypothesized difference). Crucially, the outcome of this Z-test--specifically its associated
p-value--is mathematically identical to the outcome derived from the Pearson Chi-square test
applied to a 2x2 contingency table, provided that the significance level is interpreted carefully
based on whether a one-tailed or two-tailed test is required.

When conducting this test, researchers must ensure their raw data is summarized into counts,
which is the input format required for the Crosstabs procedure in SPSS. If the data is provided in a
disaggregated format (one row per participant), it must first be aggregated into group counts. Since
SPSS expects the data structure to represent the summary statistics--the number of successes
and failures within each group--the subsequent steps will involve a mandatory process of weighting
cases to ensure the software correctly treats the counts as the actual frequency of observations.

Prerequisites and Data Preparation in SPSS

Effective execution of any hypothesis test in SPSS begins with meticulous data structure setup.
For a two proportion Z-test, the data must be organized into a format suitable for frequency
analysis. Instead of the typical structure where each row represents a single case, we use a
summarized structure with variables representing the group identifier, the outcome preference, and
the frequency count. This compact format minimizes the necessary data entry and facilitates the
weighting process crucial for accurate results.

For this specific analysis, three variables are essential in the Data View of SPSS: the group
variable (e.g., Class), the outcome variable (e.g., Preference), and the count variable (e.g., Count).
It is vital that both the group and outcome variables are defined as nominal or categorical variables
in the Variable View. The count variable, however, must contain the actual numerical frequencies
reflecting how often each combination of group and outcome occurred.

The subsequent step, known as weighting cases, is non-negotiable when using summarized data.
If this step is overlooked, SPSS will treat each row in the Data View as a single observation (N=4
in our typical 2x2 setup) rather than recognizing the actual sample size (N=60 in our example). The
weighting procedure tells the software to use the numerical value in the 'Count' variable as the
frequency weight for the row, thereby restoring the true sample sizes required for calculating
correct degrees of freedom and accurate test statistics.

Step-by-Step Example Scenario

To illustrate the application of the two proportion Z-test, consider a common educational research
scenario. Suppose a university professor manages two large sections of the same introductory
statistics course, Class A and Class B. The teacher suspects that the proportion of her students
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who prefer a specific teaching method is equal across both classes. This forms the basis of our null
hypothesis (H?).

To test this assumption, she surveys the 30 students in each class, asking a simple binary
guestion. The hypothesis test will seek to determine if the observed difference in preference rates
between Class A and Class B is substantial enough to achieve statistical significance, allowing us

to reject the claim of equality. The results of the survey are summarized below:

Class A Size: 30 students surveyed.
Count in Class A who prefer method: 23 students.
Class B Size: 30 students surveyed.
Count in Class B who prefer method: 18 students.

From these counts, we determine the sample proportions: Class A preference is 76.7% (23/30),
and Class B preference is 60.0% (18/30). The observed difference is 16.7%. The subsequent
steps will demonstrate how to input this data and use SPSS to assess whether this difference is
likely due to chance.

Phase 1. Entering and Weighting Data

Here is how to enter this summarized data into SPSS. Remember that we must input the counts for
both preference categories (Prefer and Do Not Prefer) for each class:

d4 Class g4 Preference & Count var
1 A Prefer 23
2 A Do Not Prefer 7
5! B Prefer 18
4 B Do Not Prefer 12
9
10
11
12
13
14
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Before we perform the two proportion z-test to determine if the two proportions are equal, we must
first weight the cases to correctly reflect the total sample size of 60. To do so, click the Data tab,
then click Weight Cases.

In the new window that appears, drag the Count variable into the Frequency variable panel. This
instructs SPSS to treat the numerical entries in the 'Count' column as the frequency of each row's

category combination:

@We‘\ght Cases X

O Do not weight cases
@® Weight cases by
Erequency Variable:

¢ | & Count

Current Status: Do not weight cases

Paste Reset || Cancel Help

Then click OK. The analysis will now proceed with the correct total sample size (N=60).

Phase 2: Executing the Crosstabs Procedure

With case weighting complete, we proceed to the statistical analysis. Click the Analyze tab, then
click Descriptive Statistics, then click Crosstabs:
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Analyze Graphs  Utilities Extensions Window Help
Power Analysis > E ﬂ% '\@ * Q Search ap
Meta Analysis >
Reports >
o o o var
Descriptive Statistics > Frequencies. .
Bayesian Statistics > Descriptives. .
Tables ’ [4+] Population Descriptives
C M d Proporti > .
ompare Means and Proportions Il Percentiles...
General Linear Model >
£, Explore...
Generalized Linear Models >
_ TURF Analysis
Mixed Models >
Correlate R BE Crosstabs. ..
Regression > Ratio...
Loglinear > P-P Plots._..
Neural Networks > Two-Variable or Group Q-Q Plot
Classify > [E Q-QPlots...
Dimension Reduction >
Mapping b4

In the Crosstabs dialogue box, define the

structure of the 2x2 contingency table. Drag the Class

variable to the Rows panel and drag the Preference variable to the Columns panel:
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' @Crosstabs X |
, v (G ]|
Count Class '
> Somes |
|
Column(s): |
o4 Preference '
- Cowe ]|
Layer 1 of 1 :
Previous Next '
2
[ Display layer variables in table layers

' [] Display clustered bar charts

| Paste H Reset ’Cancel” Help |

T T T T

. [] Suppress tables

To ensure SPSS calculates the statistic necessary for the proportion test, click the Statistics
button. In the new window that appears, check the box next to Chi-square:
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' @Crosstabs X |
f cd @Crosstabs: Statistics X
Statist !
Chi-square [] Correlations
| Cons |
Nominal Ordinal .
[] Contingency coefficient [[] Gamma -
[]Phi and Cramer's V [] Somers' d '
[ ] Lambda []Kendall's tau-b .
[] Uncertainty coefficient []Kendall's tau-¢ lxt !
Nominal by Interval [] Kappa
[]Eta []Risk
[J McNemar
‘ [J Cochran's and Mantel-Haenszel statistics layers
| DD'S' VT:' LU J 00ds Ao eguails |
| Su
. L Suy | Cancel | ’ Help ] |
= I N -‘

= I'l

Then click Continue. Finally, click OK in the main Crosstabs window to generate the output tables.

Interpreting the SPSS Output

The generated output includes the critical table for interpretation: the "Chi-Square Tests" table.
This table contains the necessary two-tailed p-value for the comparison of the two proportions.
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=% Crosstabs
Case Processing Summary
Cases
Valid Missing Total
N Percent M Percent N Percent
Class * Preference 60 100.0% 0 0.0% 60 100.0%
Class * Preference Crosstabulation
Count
Preference
Do Not Prefer Prefer Total
Class A 7 23 30
B 12 18 30
Total 19 41 60
Chi-Square Tests
s Asymptotic
1 Significance Exact Sig. (2- Exact Sig. (1-
Value df (2-sided) sided) sided)
Pearson Chi-Square 1.926* 1] 165 |
Continuity Correction® 1.232 1 267
Likelihood Ratio 1.943 1 163
Fisher's Exact Test .267 133
N of Valid Cases 60
a. 0 cells (0.0%) have expected count less than 5. The minimum expected countis 9.50.
h. Computed only for a 2x2 table

The two-tailed p-value for the two proportion Z-test is shown in the final table of the output in the
Pearson Chi-Square row, under the column Asymp. Sig. (2-sided). This value represents the
likelihood of observing the difference in proportions if the null hypothesis were true.

In this particular example derived from the teacher's survey data, the p-value for the two proportion
Z-test is .165. This figure is used to decide whether the observed difference between the 76.7%
preference rate in Class A and the 60.0% rate in Class B is statistically meaningful.

Formulating the Hypotheses and Conclusion

The two proportion Z-test relies on the following standard hypotheses:
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HO: The two population proportions are equal (P? = P?).
HA: The two population proportions are not equal (P? ? P?).

To determine whether we reject or fail to reject the null hypothesis (H?), we compare the calculated

p-value (0.165) to the standard significance level (a = 0.05). Since our p-value (.165) is greater
than .05, we fail to reject the null hypothesis.

This statistical decision leads to the conclusion that we do not have sufficient evidence to say that
the proportion of students in each class who prefer the specific teaching method is significantly
different. While there is a numerical difference in the sample proportions, that difference does not
reach the threshold for statistical significance, suggesting it is likely due to random sampling

fluctuation.

Conclusion and Further Resources

The two proportion Z-test, though implemented indirectly via the Crosstabs and Chi-square
procedure in SPSS, remains a fundamental tool for comparing binary outcomes between two
groups. Ensuring the data is correctly summarized and weighted is the critical prerequisite for
obtaining accurate results from the Pearson Chi-square output.

Bonus: You can also use the arabpsychology Z-test calculator to perform this analysis externally
for verification purposes.

The following tutorials explain how to perform other common statistical tasks in SPSS:
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